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 February Presentation @ 3:00 P.M. 

Favorite Utilities 
 

This month’s Meeting will be by a video 
presentation on “Favorite Utilities” by Judy 
Talour, President of the SCV Computer Club.   
 
She will explain some of the computer utili-
ties she and others use to help there comput-
ers run nearly glitch free. 
 
A brief rundown will include the following 
programs: 
 
CCleaner 
Revo Uninstaller 
AdwCleaner  
Belarc Advisor  
Avast 
Malwarebyte  
IDrive Backup 
TeamViewer 
Nitro PDF Reader  
Evernote 
 
Judy will show demonstrations of the above 
utilities, with many technical details, which 
can be used on your own computers at home, 
most of which are FREE. 
  

 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of the 
SIG meetings as a guest will be charged $3.00 per person for 
any or all meetings in that month. Afterwards, you are en-
couraged to become a member of the Plateau PC Users 
Group.  
Our Club cannot exist without you, the members.  
  
Membership Dues  

Our annual dues are now payable July 1st of each year.   
Annual dues are $24 per single person / $30 per family  
starting July 1, 2014.with partial years dues as follows: 

  
 
 

 
 
 
 
 
 
 

Student memberships (21 and under) are $10 annually.   
Corporate memberships are $30 a year for the first two  
memberships and $10  a year for each additional  
membership from the same company.   
Contact the PPCUG Treasurer (931) 707-3677  
for pro-rated dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to 
help one another in the area of advice and tutorial instruc-
tion over the phone.  If you should require more involved 
services or instruction, we have a few members who are 
very knowledgeable in several areas.  As a responsible  
consumer, it is up to you to discuss, before retaining a mem-
ber, any and ALL charges for repair services and time con-
suming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for 
individuals for services rendered, nor the responsibility to 
intervene between members who enter into a contract 
among themselves. 
 
The GAZETTE is published using the following:  Microsoft 
Word, Microsoft Publisher, and Microsoft Windows.  The 
Gazette is the monthly newsletter of the Plateau PC Users 
Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is made 
by the PPCUG, the Gazette editorial staff or its contributing 
editors.  This extends to all losses incidental or consequen-
tial from the use or non-use of any information in any issue 
of the Gazette. 
 
All images used in the newsletter, website, blogs, class mate-
rials or handouts (“media”)  are obtained from a “free use” 
source, preferably images that have been released as “CCO 
Public Domain”. 

 
2019-2020 PPCUG, Inc. Board Members 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Richard Del Frate (931) 456-2251 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

   

Directors at Large 

Gordon Botting Richard Del Frate Barbara Duncan 

Charlie Merrick Frank Wade Bob Willis 

   

 
Join In 

Jul-Sep  
Annual 

Dues 

Oct-Dec  Jan-Mar Apr-Jun 

Single: $24 $18 $12 $6 

Families: 
$30 $22 $15 $7 

Printed by, Business Equipment Clinic 
539 West Ave. Suite 101  Crossville TN 38557 
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Up Coming Meeting for March 2020 
Note: Winter Hours 3:00 P.M. 

 
The next General Meeting of the 
PLATEAU PC USERS GROUP 

Will be on Tuesday, March 10, 2020. at 3:00 P.M 

** Visit the PPCUG Website ** 

At: www.PPCUGinc.com. 
 
Read all about our club activities and scheduled monthly meetings, also current and past 
issues of the  Gazette Newsletter. Links also to the Meeting Handouts on past presenta-
tions. 
 

Send your comments and suggestions to the PPCUG Webmaster, Alan Baker 
jackal33980@gmail.com  (931) 239-0877 

Cool Tips & Sites 

 
Memory Troubles 

 
Faulty memory can cause all kinds of off computer behavior, and not only are memory problems behind 
odd issues, but they can also be difficult to detect, too. Luckily,  
 
Windows has a RAM checker that can help identify issues. Go to Start, type Memory, and then click on the 
Windows Memory Diagnostic link. 
 

 
 
Windows will reboot your computer, run a check of your memory, and let you know if it detected any  
problems. 
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PPCUG Members and Guests at our General Meeting about the Windows 7 Security Sunset presentation 

Disable Background Apps 
 

Some apps run in the background, and they take system resources and heat up the PC. So, it’s better to disa-
ble them and start them when you need them. This will help you to speed up the system performance. 
 
Follow these following steps to turn off background-running apps: 
 

 Firstly, select the Start button and go to 
 Click Privacy, go to the last option in the left panel called Background apps. 
 Switch off the toggles to turn off background apps you don’t need or use. 
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How to Edit Images in Microsoft Word 
By Ben Stockton  

 
Microsoft Word includes several image editing tools that allow you to make  images in your documents. 
Here’s how to use You don’t need expensive photo editing software like Photoshop to edit photos and other 
images for Microsoft Word documents. Although the Microsoft Office Picture Manager has been retired, 
there are still plenty of built-in tools to edit images in Word. 
Microsoft Word allows you to format colors and brightness, add borders, crop image sizes, add special  
effects and more, so here’s how to do it. While the instructions may vary, these instructions should work for 
Word 2016 and onward, including Office 365 and Online. 

Cropping Images in Microsoft Word 
There are a few ways to crop an image in Microsoft Word. Start by inserting the image into your Word  
document (Insert > Pictures) and selecting the image. 
 

 
 
To begin formatting your selected image, click Format > Crop (or Format > Crop > Crop). You can also 
enter the image cropping mode by right-clicking the image and selecting Crop. 
This will change the outline around your image from resizing to cropping.  
 

 
(Continued on page 6) 
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Move the crop outline tools around your image to reduce the image area to its final size. Greyed out areas 
will be removed from the final image once the crop edit has been confirmed. 
Once you’re happy, click once outside of the image, or press Enter on your keyboard. 
 

 

Formatting Image Colors 
Word allows you to format the colors used in your image without needing to export it to a photo editor first. 
You can customize the image sharpness, brightness, saturation, tone, and contrast levels, either manually or 
using one of several preset filters. 
To access the image formatting tools, right-click on your image and press Format Picture at the bottom. 
 

 
 
This will bring up the Format Picture menu on the right-hand side. Click the Picture icon (furthest r ight) to 
access the image color editing tools. 
Under Picture Corrections, move the sliders for each category to sharpen or soften an image, or to  
increase or decrease the brightness and contrast levels. You can also click Presets for each category, select-
ing one of the thumbnails to apply those changes to your image instead. 

 

(Continued from page 5) 

(Continued on page 7) 
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Under Picture Color, you can change the tone and saturation levels for your selected image. Move 
the sliders for each option left or right to increase or decrease each level.  
Click Presets to set these levels using one of the provided preset options. 
 

 
 
If you’re unhappy with any of the color changes you’ve made, click the Reset button underneath each 
category to return your image to its original state. 

Adding Special Effects to Images 
Microsoft Word also includes a number of special effects that can be easily applied to images. These in-
clude image shadow, glow, and reflection, soft edges, as well as a 3D bevel effect.  
To add these special effects, enter the Format Picture menu (right-click > Format Picture) and click 
the Effects icon (second from the left). Click on each sub-category to access each setting. 
To add a shadow to your image, click Shadow and move the sliders to set transparency, size, angle, 
color, etc.  
 
You can also click Preset to preview and add a Word-defined drop shadow instead. 
 

 
 
Click Reflection and follow the same instructions to add a custom or preset image reflection to your 
image. Do the same to Glow to add an image glow, and Soft Edges to soften the edges around your  
image. 
To add a 3D bevel effect to your image, click 3-D Format. Select the effect you want for both the top 
and bottom sections of your image by clicking Top Bevel and Bottom Bevel, selecting one of the  
pre-defined options. 
You can also customize the depth, contour, material effect and lighting levels for your 3D bevel effect  

(Continued from page 6) 
 

(Continued on page 8) 
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using the drop-down menus and option boxes. 
 

 
 
You can also add one of several preset artistic effects to your image. These combine several effects into 
one to change your image design. 
To do this, click the Artistic Effects sub-category, then click the Artistic Effects icon. Select one of the 
preset options using your mouse to apply it to your image. 
 

 
 

Compressing Images in Microsoft Word 
Adding images to a Word document can vastly increase the size of it. By compressing the images, you can 
reduce the file size of your document as a whole. 
To format a single picture, click Format > Compress Images and make sure that the Apply only to this  
picture checkbox is enabled. If you want to compress all of your attached images, click to uncheck this 
checkbox. 
Compressing images will reduce the quality on a sliding scale from HD quality (330 pixels per inch) to 
basic email quality (96 pixels per inch) 
. 

 
 

(Continued from page 7) 
 

(Continued on page 9) 
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The higher the quality, the bigger the Word file, so choose your preferred quality, then click OK to com-
press your images. 

Basic Image Editing Made Easy 
These editing tools make it easy to make basic changes to images in Microsoft Word. You can also resize 
images in Windows 10 without needing an image editor, too. 
 
If you do find yourself needing to make bigger changes to your images, you can try some of these free  
Photoshop alternatives instead. 

 

How to Install the new Microsoft Edge Browser 
By Brian Burgess  
Last Updated on January 16, 2020  

 
Microsoft’s new Chromium-based Edge browser is now available  
Microsoft this week is officially launching the final version of its new Edge browser. It’s based on the Open 
Source Chromium code as Google Chrome and is available on Windows 7, 8, 10, and macOS. It’s also 
available for Android and iOS with a version for Linux coming later this year. 
The new Edge is going out to Windows 10 users automatically in a staggered rollout via Windows Update. 
But anyone can download and install it now. 
Installing the browser is a straightforward process. However, there are a few advanced features you might 
want to note when installing it on your system. 

Install the New Microsoft Edge Browser 
To get started head to the Microsoft Edge download page. 
Then click the Download button for Windows 10 or click the dropdown to choose the OS you want to in-
stall it on. Note that the links for the mobile versions will kick you over to the respective app store. 
 

 

(Continued from page 8) 
 

(Continued on page 10) 
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Once you run the installer you will be greeted with the welcome screen. Here you can choose to import 
data from Google Chrome. Or, if you want to start with a clean slate, click the Continue without import-
ing button. 

 
 
If you want additional options, click the More import options link. Then you can choose the browser and 
type of data you want to import into the new Edge. 
 

 
 
Next, configure your new tabs. There are three different layouts including Inspirational, Informational, 
and Focused. Note that you can change the layout later in settings. 
 

 

(Continued from page 9) 

(Continued on page 11) 
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Then configure how you want your data to sync to other devices you’re signed into with your Microsoft 
account. If you click Next here it will sync favorites, saved passwords, settings, addresses and more. If you 
don’t want to sync browser data between just toggle the switch to No. 
 

 
 
To choose which data to sync click the Customize sync settings link and choose which items you do or 
don’t want. Here you can also sign out of your Microsoft account. 
 

 
 
On the final screen, you can choose to keep or disable Microsoft’s personalized ads, search, news, and oth-
er items. Microsoft boasts the privacy aspect of the new browser, but like Google, it makes money from 
advertising. 

(Continued from page 10) 
 

(Continued on page 12) 
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But here it does give you the choice to opt-out. If you don’t want to share your browsing and search history 
flip the switch to No. When you’re finished click the Confirm button. 
 

 

Start Using the New Edge 
That’s it. Now you can start browsing in the new Microsoft Edge browser. If you’re already a Google 
Chrome user, you’ll find that Edge is easy to dive into and start using. 
 

 
 
The new version of the Edge browser supports 4K streaming, Dolby audio, and inking in PDF support. 
In addition, it includes an Internet Explorer mode which is aimed at business users. 

New Microsoft Edge on Mobile 
The new Microsoft Edge is also available for iOS and Android, too. After installing it, make sure to sign in 
with the same Microsoft account that you use on your computer to sync favorites, settings, passwords, and 
other data 
 

(Continued from page 11) 
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Best Uninstaller for Windows 10 
 

Clean Up the Disk 
 

After using your computer for some time, it gets filled with lots of useless data that lodges space. These 
can be a headache as they cause a huge amount of performance degradation of windows 10. That’s why 
you need to get rid of them. 

You have to run Disk Cleanup to free up space on your system, and for that, you need to perform these 
steps: 

 Click Start and then go to File Explorer. After that click This PC. 
 

 On the right side, under Devices and Drives, select the Local Disk (C � and then click and choose 
the last option Properties from the context menu. 
 

 Then, switch to the General tab and under Capacity, click on Disk Cleanup 
 

 After the tool completes scanning your system for removable files, you can select the category of 
files you wish to delete and click OK to remove them. 
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Did Ring employees spy on you? 
  

You've probably seen the headlines - Ring doorbell employees f ired for spying 

The way the news has headlined this you'd think groups of employees from Amazon's Ring Doorbell divi-
sion were sitting around spying on your home all day. Don't panic just yet. Amazon did fire four separate 
employees over the past for years for violating the privacy of customers. That's certainly not good news 
but that doesn't mean dozens of employees are not watching the live feed from your doorbell cam. 

 

Ring Doorbells have ballooned in popularity. These motion-activated doorbells let you see who's at your 
door and talk to them by checking an app on your phone. You can do this whether you're home or in Tim-
buktu. You'll also get a recording of what happens on the front porch that you can access later. All without 
having a wired security system. These recordings have been used to catch package thieves and other crimi-
nals. But, as with any video recording stored in the cloud, there's the chance someone might look at your 
stuff. 

Everyone who works at Ring doesn't have access to your video feed. According to Amazon, employees are 
only allowed to access your stored videos if you give them permission and only for the purpose you've 
contacted them for. (Most likely some type of troubleshooting.) In the past four years, four employees who 
had been given permission by consumers to access their videos looked at more data than was necessary to 
the task at hand. All four employees were fired. Amazon says that it also monitors any authorized employ-
ee access to data and makes sure employees are looking at anything more than they need. 

This admission from the company came in response to a letter from U.S. Senators looking for answers 
about privacy concerns. The letter was prompted by reports that Ring's development team in Ukraine had 
unrestricted access to the stored data of all users.  Amazon denied that claim, saying that no one has unre-
stricted access to customer data and video and that employees only have access to public videos of people 
who have chosen to share the videos with them. 
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PLATEAU PC USERS GROUP, Inc. 

APPLICATION FOR MEMBERSHIP 

  

          ____ New Member                    ____ Renewing Member 
  

  

Return this application, with check for annual dues payable to "PLATEAU PC USERS GROUP." Return to the club 
Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 3787, Crossville, TN 38557. Our annual dues are 
now payable on July 1st of each year.  Annual dues are $24 per single person / $30 per family starting 7/1/2014 with 
partial years’ dues as follows: 
 

 

 

Join In 
July-Sept 

Annual Dues 
Oct-Dec Jan-Mar Apr-June 

Single: $24 $18 $12 $6 

Families: $30 $22 $15 $7 

  

    

Date: ______________           Amount Paid: $ ____ :.00,  by Cash ___ , or    Check ( #_____________ ) 
                                                

    _____________________________________________ ________________________________  _____________________________________ 

          Last Name         First Name Family Members (if family membership) 

_______________________________________________________________________ 

           Address:  

____________________________          _____ _____________ (_____  )____________________ 

    City                        State     Zip Code Phone Number 

 
E-Mail address:  —————————————————————————————— 
 

 
I have belonged to a Computer Club before. Yes    _____    No _____ _ 
 
l have used PCs since (year):   __________     
 
I have knowledge in the following areas that I would be willing to share with club members:  
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
 
January 2020 
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March 2020 

Sun Mon Tue Wed Thu Fri Sat 

1 2 3 4 2:00 P.M. 

PPCUG Board 
Mtg. 

5 6 7 

8 9 10 3:00 .M. 

General Mtg.  
Presentation. 
Followed By 
Q&A Session 
  

11 12 13 14 

15 16 17 18 19 20 21 

22 23 24 25 26 27 28 

29 30 31     


